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Copyrights

© Cypress Semiconductor Corporation, 2018-2019. This document is the property of Cypress Semiconductor Corporation
and its subsidiaries ("Cypress"). This document, including any software or firmware included or referenced in this document
("Software"), is owned by Cypress under the intellectual property laws and treaties of the United States and other countries
worldwide. Cypress reserves all rights under such laws and treaties and does not, except as specifically stated in this para-
graph, grant any license under its patents, copyrights, trademarks, or other intellectual property rights. If the Software is not
accompanied by a license agreement and you do not otherwise have a written agreement with Cypress governing the use of
the Software, then Cypress hereby grants you a personal, non-exclusive, nontransferable license (without the right to subli-
cense) (1) under its copyright rights in the Software (a) for Software provided in source code form, to modify and reproduce
the Software solely for use with Cypress hardware products, only internally within your organization, and (b) to distribute the
Software in binary code form externally to end users (either directly or indirectly through resellers and distributors), solely for
use on Cypress hardware product units, and (2) under those claims of Cypress's patents that are infringed by the Software
(as provided by Cypress, unmodified) to make, use, distribute, and import the Software solely for use with Cypress hardware
products. Any other use, reproduction, modification, translation, or compilation of the Software is prohibited.

TO THE EXTENT PERMITTED BY APPLICABLE LAW, CYPRESS MAKES NO WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, WITH REGARD TO THIS DOCUMENT OR ANY SOFTWARE OR ACCOMPANYING HARDWARE, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PUR-
POSE. No computing device can be absolutely secure. Therefore, despite security measures implemented in Cypress hard-
ware or software products, Cypress shall have no liability arising out of any security breach, such as unauthorized access to
or use of a Cypress product. CYPRESS DOES NOT REPRESENT, WARRANT, OR GUARANTEE THAT CYPRESS PROD-
UCTS, OR SYSTEMS CREATED USING CYPRESS PRODUCTS, WILL BE FREE FROM CORRUPTION, ATTACK,
VIRUSES, INTERFERENCE, HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (collectively, "Secu-
rity Breach"). Cypress disclaims any liability relating to any Security Breach, and you shall and hereby do release Cypress
from any claim, damage, or other liability arising from any Security Breach.  In addition, the products described in these mate-
rials may contain design defects or errors known as errata which may cause the product to deviate from published specifica-
tions. To the extent permitted by applicable law, Cypress reserves the right to make changes to this document without further
notice. Cypress does not assume any liability arising out of the application or use of any product or circuit described in this
document. Any information provided in this document, including any sample design information or programming code, is pro-
vided only for reference purposes.  It is the responsibility of the user of this document to properly design, program, and test
the functionality and safety of any application made of this information and any resulting product. "High-Risk Device" means
any device or system whose failure could cause personal injury, death, or property damage.  Examples of High-Risk Devices
are weapons, nuclear installations, surgical implants, and other medical devices. "Critical Component" means any component
of a High-Risk Device whose failure to perform can be reasonably expected to cause, directly or indirectly, the failure of the
High-Risk Device, or to affect its safety or effectiveness. Cypress is not liable, in whole or in part, and you shall and hereby do
release Cypress from any claim, damage, or other liability arising from any use of a Cypress product as a Critical Component
in a High-Risk Device. You shall indemnify and hold Cypress, its directors, officers, employees, agents, affiliates, distributors,
and assigns harmless from and against all claims, costs, damages, and expenses, arising out of any claim, including claims
for product liability, personal injury or death, or property damage arising from any use of a Cypress product as a Critical Com-
ponent in a High-Risk Device. Cypress products are not intended or authorized for use as a Critical Component in any High-
Risk Device except to the limited extent that (i) Cypress's published data sheet for the product explicitly states Cypress has
qualified the product for use in a specific High-Risk Device, or (ii) Cypress has given you advance written authorization to use
the product as a Critical Component in the specific High-Risk Device and you have signed a separate indemnification agree-
ment.

Cypress, the Cypress logo, Spansion, the Spansion logo, and combinations thereof, WICED, PSoC, CapSense, EZ-USB, F-
RAM, and Traveo are trademarks or registered trademarks of Cypress in the United States and other countries. For a more
complete list of Cypress trademarks, visit cypress.com. Other names and brands may be claimed as property of their respec-
tive owners.
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Safety Information

The CY8CKIT-005 MiniProg4 Program and Debug Kit is intended for use as a development platform
for hardware or software in a laboratory environment. In a domestic environment, this product may
cause radio interference. In such cases, you may be required to take adequate preventive
measures. In addition, this board should not be used near any medical equipment or RF devices.

Attaching additional wiring to this product or modifying the product operation from the factory default
may affect its performance and cause interference with other apparatus in the immediate vicinity. If
such interference is detected, suitable mitigating measures should be taken.

The CY8CKIT-005 MiniProg4 Program and Debug Kit, as shipped from the factory, has been verified
to meet with the requirements of CE as a Class A product.

General Safety Instructions

ESD Protection

ESD can damage boards and associated components. Cypress recommends that you work on the
board at an ESD workstation, if available. Otherwise, use appropriate ESD protection, such as an
antistatic wrist strap attached to a ground, when handling parts. 

The CY8CKIT-005 MiniProg4 Program and Debug Kits are sensitive to
electrostatic discharge (ESD). Electrostatic charges accumulate on the
human body and on other equipment. Devices that are subjected to high-
energy discharges can suffer permanent damage. Proper ESD
precautions are recommended to prevent loss of functionality. Store
unused CY8CKIT-005 MiniProg4 Program and Debug Kits in the
protective shipping package.

End-of-Life/Product Recycling

The end-of life for this kit is five years from the date of manufacture mentioned as bar
code on the back of the box. Contact your nearest recycler for discarding the kit.
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1 Introduction

The MiniProg4 Program and Debug Kit is an all-in-one programmer and debugger for PSoC 4,
PSoC 5LP, and PSoC 6 MCU devices. MiniProg4 also provides USB-I2C, USB-SPI and USB-UART
bridging functionality. The MiniProg4 provides a special feature enabling users to write their own
custom firmware through the custom application mode. 

Figure 1-1.  MiniProg4

1.1 Kit Contents

The CY8CKIT-005 PSoC® MiniProg4 Program and Debug Kit includes:

■ MiniProg4 programmer/debugger

■ 10-pin ribbon cable

■ USB Type-A to Type-C Cable

■ Quick Start Guide

1.2 Programming and Debugging

The MiniProg4 programmer/debugger provides the flexibility to work with SWD programming and
debugging interfaces. MiniProg4 supports 32-bit Arm® Cortex®-M0/M0+/M3/M4 PSoC devices. 

The MiniProg4 debugger is supported by the software tools PSoC Creator, ModusToolbox™,
Cypress Programmer, and PSoC Programmer.

1.3 Bridging

MiniProg4 supports USB-I2C, USB-UART and USB-SPI as standard bridging protocols for any
device. The MiniProg4 bridging capabilities are used by PSoC Creator, ModusToolbox, Cypress
Programmer, PSoC Programmer, Bridge Control Panel, and other applications. Tuning software
tools such as the CapSense Tuner provided by Cypress also use these capabilities. 
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1.4 Documentation Conventions

Table 1-1.  Document Conventions for User Guides

Convention Usage

Courier New Displays file locations, user-entered text, and source code:
C:\...cd\icc\

Italics
Displays file names and reference documentation:
Read about the sourcefile.hex file in the PSoC Designer User Guide.

[Bracketed, Bold]
Displays keyboard commands in procedures:
[Enter] or [Ctrl] [C]

File > Open
Represents menu paths:
File > Open > New Project

Bold
Displays commands, menu paths, and icon names in procedures:
Click the File menu, and then click Open.

Times New Roman
Displays an equation:
2 + 2 = 4

Text in gray boxes Describes cautions or unique functionality of the product.
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2. Installing MiniProg4

This chapter shows how to install MiniProg4 and its associated PC software.

2.1 MiniProg4

Figure 2-1.  Top View

Figure 2-2.  Bottom View
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Installing MiniProg4

2.2 MiniProg4 Installation

The MiniProg4 programmer/debugger is supported by PSoC Programmer, ModusToolbox, Cypress
Programmer, and PSoC Creator. Other software, such as Bridge Control Panel, use the PSoC
Programmer COM layer to support MiniProg4 functionality.

Note: PSoC Programmer is compatible only with the Windows Operating System however, Cypress
Programmer is compatible with Windows, macOS, and Linux. To understand the differences
between PSoC Programmer and Cypress Programmer, please see the Cypress Programming
Solutions page at http://www.cypress.com/products/psoc-programming-solutions.

1. Download and install PSoC Programmer or Cypress Programmer. Follow the on-screen 
instructions to install the software.

Each programming tool supports a subset of Cypress devices. See respective tool 
documentation for which device each supports. 

2. Launch PSoC Programmer or Cypress Programmer and connect the MiniProg4 to your 
computer’s USB port using the provided USB cable. When properly connected, and drivers have 
been installed, the Mode LED either turns ON or will be ramping (slowly increasing and 
decreasing brightness) depending on the mode. 

Note that the MiniProg4 drivers are automatically installed.

3. In PSoC Programmer, to connect to the port, in the Port Selection pane, click the MiniProg4 
device. You can also click Connect/Disconnect button as shown in Figure 2-3.

If the connection is successful, a status indicator in the lower-right corner of the PSoC 
Programmer window turns green and shows “Connected”.

You can now use MiniProg4 to program the target device by clicking the Program button. 

Figure 2-3.  PSoC Programmer: MiniProg4 Connect/Disconnect and Program 

For more information on how to use PSoC Programmer, see Help Topics under the Help menu 
in PSoC Programmer or press [F1].
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Installing MiniProg4

In Cypress Programmer, to connect to the MiniProg4 probe, click Connect/Disconnect button as 
shown in Figure 2-4.

If the connection is successful, a status indicator in the lower-right corner of the Cypress 
Programmer window turns green and shows “Connected”.

You can now use MiniProg4 to program the target device by clicking the Program button.

Figure 2-4.  Cypress Programmer: MiniProg4 Connect/Disconnect and Program 

For more information on how to use Cypress Programmer, see View Help under the Help menu 
in Cypress Programmer or press [F1]. 
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Installing MiniProg4

2.3 MiniProg4 LEDs

MiniProg4 has three indicator LEDs - Mode (Amber), Status (Green), and Error (Red) as shown in
Figure 2-5. Table 2-1 indicates the behavior of these LEDs for various operations. 

Figure 2-5.  MiniProg4 LEDs 

Table 2-1.  LED representation for various operations of MiniProg4

Programming Mode Programming Status

Three LEDs

Mode Indicator 
(Amber LED)

Status Indicator 1 
(Green LED)

Status Indicator 2 
(Red LED)

CMSIS-DAP HID

Programming

Ramping (1 Hz)

8 Hz OFF

Success ON OFF

Error OFF ON

Idle OFF OFF

CMSIS-DAP Bulk

Programming

ON

8 Hz OFF

Success ON OFF

Error OFF ON

Idle OFF OFF

Bootloader N/A 1 Hz OFF OFF

Custom Application N/A 8 Hz ON ON
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2.4 MiniProg4 Buttons

MiniProg4 has two buttons that enable switching between various operating modes. Figure 2-6
shows the location of the buttons. In order to understand switching MiniProg4 modes, refer to
Figure 2-7.

On power-up, MiniProg4 is in CMSIS-DAP/BULK Mode by default. If the Mode Select button is
pressed, MiniProg4 enters CMSIS-DAP/HID mode. If the Custom App button is pressed, MiniProg4
enters custom application mode where a user can run their own custom applications on the MCU
contained in the MiniProg4. See Figure 2-7 for details. 

For details of LED indications of various modes of MiniProg4, refer to Table 2-1.

Figure 2-6.  MiniProg4 Buttons 

Figure 2-7.  Various MiniProg4 Button Modes 
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3. Technical Description

MiniProg4 is a protocol translation device. With MiniProg4, the PC host software can communicate
through a USB port to the target device to be programmed or debugged, as shown in Figure 3-1.
Table 3-1 lists the protocols that are supported by each connector. MiniProg4 enables
communication with the target devices using I/O voltage levels from 1.5 V to 5 V. 

Figure 3-1.  System Block Diagram 

Table 3-1.  Connectors / Communication Protocol Support

Connector SWD I2C SPI
UART (With and 

Without Flow Control)

5-pin Supported N/A N/A N/A

10-pin Supported N/A N/A N/A

6x2 header N/A Supported Supported Supported

PC

MiniProg4

Target Board

USB Cable

10-pin Ribbon 
Cable or 5-pin 

Direct 
Connection

12-pin 
Communication 

Header

SWD

I2C/
UART/

SPI
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Technical Description

3.1 Interfaces

3.1.1 SWD

ARM-based devices support the Serial Wire Debug (SWD) protocol. The PSoC 4, PSoC 5LP, and
PSoC 6 MCU device families implement this standard, which offers programming and debugging
functions. MiniProg4 supports programming and debugging of PSoC 4, PSoC 5LP, and PSoC 6
devices using SWD through the 5-pin or 10-pin connector.

Before programming a PSoC 4, PSoC 5LP, or PSoC 6 MCU device, make sure you review the
electrical connection requirements in the respective device datasheet or in the PSoC 4, PSoC 5LP,
and PSoC 6 MCU device programming specifications. You can find the datasheets and
programming specifications here: 

www.cypress.com/PSoC4
www.cypress.com/PSoC5LP
www.cypress.com/PSoC6

3.1.2 I2C

I2C is a common serial interface standard. It is mainly used for communication between
microcontrollers and other ICs on the same board but can also be used for intersystem
communications. MiniProg4 uses an I2C multimaster host controller that allows the tool to exchange
data with I2C-enabled devices on the target board. For example, this feature may be used to tune
CapSense® designs.

MiniProg4 serves as a USB-I2C bridge (acts as I2C Master) that can be used to communicate with a

I2C slave devices through the Bridge Control Panel software. For I2C connections use the 6×2

connector. MiniProg4 has internal pull-up resistors and supports I2C speed up to 1 MHz.

3.1.3 SPI

The Serial Peripheral Interface (SPI) is a synchronous serial communication interface specification
used for short distance communication, primarily in embedded systems. SPI devices communicate
in full duplex mode using a master-slave architecture with a single master. 

MiniProg4 serves as a USB-SPI bridge (acts as SPI Master) that can be used to communicate with a
SPI slave devices through the Bridge Control Panel software. For SPI connections use the 6x2
connector. MiniProg4 supports SPI speed up to 6 MHz.

3.1.4 UART with and without Flow Control

UART is another common serial interface standard. MiniProg4 supports UART, which allows the tool
to receive data from UART enabled devices on the target board. MiniProg4 provides UART
communication both with and without hardware flow control. In order to enable flow control, RTS and
CTS pins are provided in the 6x2 I/O header. If flow control is not required, CTS and RTS pins can
be left floating. Terminal emulators such as Tera Term or PuTTY can be used to communicate with
the target PSoC device. MiniProg4 supports UART speed up to 115200 Baud Rate.

3.1.5 Reference

For more information on the PSoC 4, PSoC 5LP, and PSoC 6 MCU's JTAG, SWD, and I2C
interfaces, see the PSoC 4, PSoC 5LP, and PSoC 6 Technical Reference Manuals. 

For more details on how to use MiniProg4 with Bridge Control Panel, refer to the Bridge Control
Panel Help document.
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Technical Description

3.2 Connectors

3.2.1 5-Pin Connector

The 5-pin connector is configured as a single row with a 100-mil pitch. Suggested mating connector
part number is Molex Connector Corporation 22-23-2051.

Figure 3-2.  5-Pin Connector with Pin Assignments 

Note: If the design requires MiniProg4 to be directly plugged to the target board with a 5-pin header,
adequate mechanical clearance shall be provided near the 5-pin header on the target board. The
width & height of MiniProg4 (5-pin header area) is 25mm x 13mm. If the design cannot meet the
required mechanical clearance, use a stackable header (such as Proto-PIC 20690). 

3.2.2 10-Pin Connector

The 10-pin connector is configured as a dual row with 50-mil pitch. It is used with a ribbon cable
(provided) to mate to a similar connector on the target board. The signal assignment is shown in
Figure 3-3. Suggested mating connector part number is CNC Tech 3220-10-0300-00 or Samtec Inc.
FTSH-105-01-F-DV-K-TR.

Figure 3-3.  10-Pin Connector with Pin Assignments 

MiniProg4 
(End View)

Mating 
Connector

SDAT

SCLK

XRES

GND

VTARG

XRES

TDI

VTARG

GND

GND

GND

GND

TDI

TDO / SWO

TMS / SWDIO

VTARG

GND

Pin 1

Note The ribbon 
cable connector 

extends beyond the 
body of the 

connector.  Be sure 
to allow room.

GND

GND

GND

TCK / SWCLK

Downloaded from Arrow.com.Downloaded from Arrow.com.Downloaded from Arrow.com.Downloaded from Arrow.com.Downloaded from Arrow.com.Downloaded from Arrow.com.Downloaded from Arrow.com.Downloaded from Arrow.com.Downloaded from Arrow.com.Downloaded from Arrow.com.Downloaded from Arrow.com.Downloaded from Arrow.com.Downloaded from Arrow.com.Downloaded from Arrow.com.Downloaded from Arrow.com.

http://www.arrow.com
http://www.arrow.com
http://www.arrow.com
http://www.arrow.com
http://www.arrow.com
http://www.arrow.com
http://www.arrow.com
http://www.arrow.com
http://www.arrow.com
http://www.arrow.com
http://www.arrow.com
http://www.arrow.com
http://www.arrow.com
http://www.arrow.com
http://www.arrow.com


CY8CKIT-005 MiniProg4 Program and Debug Kit Guide, Doc. # 002-19782 Rev. *B 15

Technical Description

Here is a summary of the protocols and related pin assignments. The pin mapping is also shown on
the back of the MiniProg4 case. 

3.2.3 6x2 Connector

This connector supports all the communication protocols like I2C, SPI, UART (with or without flow
control supported by MiniProg4). Figure 3-4 shows the pin assignments. They are also shown on the
back of the MiniProg4 case.

Figure 3-4.  6x2 Connector Pin Assignments 

Table 3-2.  Communication Protocol Pin Assignments

Protocol Signal 5-Pin 10-Pin

SWD

SDIO 5 2

SCK 4 4

XRES 3 10
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Technical Description

3.3 Power
MiniProg4 can be powered using the USB interface. 

On kits/boards where there is a single power supply for the entire board, MiniProg4 can supply
power to the board. However, this supply is limited to approximately 200 mA, and is protected
against excess current draw. You can select 1.8 V, 2.5 V, 3.3 V, or 5 V from PSoC Programmer or
Cypress Programmer. The 5 V supply may vary between 4.25 V–5.5 V, because it is supplied
directly from the USB port. The maximum deviation for other voltages is +5%.

Note: Some PSoC device families do not support 5 V operation. Refer to the respective device
datasheet for supported voltage selection. 

Voltage stress beyond acceptable limits can permanently damage
MiniProg4. Programming signals can withstand over-voltage up to
maximum 12 V and minimum up to –5 V. Communication bridge signals
(I2C, UART & SPI) can withstand over-voltage only up to maximum 6 V
and minimum up to –1 V.
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A. Appendix

A.1 Regulatory Compliance Information

The CY8KCIT-005 MiniProg4 Program and Debug Kit complies with the CE-Low Voltage Directive
2006/95/EC (Europe) safety requirement. It has been tested and verified to comply with the following
electromagnetic compatibility (EMC) regulations.

■ CISPR 22 - Emissions

■ EN 55022 Class A - Immunity (Europe)

■ CE - EMC Directive 2004/108/EC

■ CE Declaration of Conformity
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Revision History

Document Revision History
Document Title: CY8CKIT-005 MiniProg4 Program and Debug Kit Guide

Document Number: 002-19782

Revision ECN# Issue Date
Origin of 
Change

Description of Change

** 6284494 10/31/2018 NMIT New kit guide.

*A 6378762 11/08/2018 SRDS Updated Installing MiniProg4 chapter on page 7:

Updated “MiniProg4 Installation” on page 8:

Updated description.

Updated Figure 2-3.

*B 6581024 05/24/2019 SRDS Updated Copyright information.
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